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EXPERIMENT NO-I 

NAME OF THE EXPERIMENT: Write a program to solve one dimensional steady state heat 

conduction boundary value problem. 

 

AIM: Solution for the one dimensional steady state heat conduction equation using finite           

difference explicit method using MATLAB. 

 

The one dimensional steady heat conduction equation is given by 

   

                                   
𝜕𝑇

𝜕𝑥
=0      ________________________________ (1) 

 
This equation represents the second order derivatives of temperature ‘T’ with respect to space ‘x’ 

for a spacial domain of 0 to L. The boundary condition is given by; 

    

                                           T(x=0) = T1; 

                                           T(x=L) = T2; 
 
 

Numerical Solution:- 

 
A. Preprocessor:- 

 

1. Geometry Creation:- 
 

 
2. Meshing:- 

 
 

3. Setup:-  

     

                                  Applying Boundary Condition: 
 
                                  Ti-1 = 500K; 

                                  Ti+3 = 200K; 
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B. Solver :- 

    

                The complate MATLAB code is given below to solve this problem 

         %%% the solution of steady state one dimensional heat conduction eq%%%% 

clc 

clear all 
 
%%%%%%%%%%%%%%%%%%%%%%%%% PRE-PROCESSOR 

%%%%%%%%%%%%%%%%%%%%%%%%% %%%%%% 
 
n=4; % number of cells are(n+1)& number of grids are (n+2). it is number of unknown grids 

m=n; % m shows the number of rows 

C=zeros(m,n); % the coefficient matrix 

L=1; %length of the rod in metre 

t0=500; % boundary condition at left end of the rod 

t5=200; % % boundary condition at right of the rod 

T=zeros(m,1); % the unknown matrix 

S= zeros(m,1); % the known matrix 

S(1,1)= -500; 

S(m,1)= -200; 

for i=1:n 

    C(i,i)=-2; 

end 

for i=1:n-1 

    C(i,i+1)=1; 

    C(i+1,i)=1; 

end 

 
 T= inv(C)*S; 

T1=zeros(m+2,1) %full temperature solution matrix 

T1(1,1)= 500;    %  LEFT BC 

T1(m+2,1)= 200;   % RIGHT BC  

X=zeros(m+2,1) %rod length descretised matrix 

X(1,1)=0; 

X(m+2,1)=1; 

%%%%%%%%%%%%%%%%%%%%%%%%%% SOLVER 

%%%%%%%%%%%%%%%%%%%%%%%%%%% 

for i=2:(m+1) 

    T1(i,1)= T(i-1,1); 

    X(i,1)= X(i-1,1)+1/(n+1); 

end 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% POST-PROCESSOR 

%%%%%%%%%%%%%%%%% 

plot(X,T1,'ro') 
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grid on 

T2= zeros(m+2,1); %analytical solution of the problem 

err= zeros(m+2,1); % difference b/w analytical solution and numerical solution 

for i= 1:m+2 

    T2(i,1)= (T1(m+2,1)-T1(1,1))/L*(X(i,1))+T1(1,1); 

     

        err(i,1)= T2(i,1)- T1(i,1); 

end 

 
plot(X,T1,'b--') % variation of temperature along x axis 

title(' Steady state temperature variation along the rod length ') 

xlabel('Rod length (m)') 

ylabel('Temperature (K)') 

grid on 

 hold on 

 plot(X,T2,'r*') 

 hold on 

 plot(X,err,'Ko') 

 hold off 

 legend('Numerical soln','Analytical soln','Error') 

 

C. Post- Propecessor: 
 
 
The following graph shows the simulation result. 
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                                                                                           **END** 
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EXPERIMENT NO-II 

NAME OF THE EXPERIMENT: Write a program to solve one dimensional transient heat 

conduction equation using explicit finite difference method. 

 

AIM: - solution of one dimensional transient heat conduction through a bar using finite 

difference explicit method. 

 

The one dimensional transient heat conduction equation is given as, 

 

 

 ……………………………………….(1) 

 

 

where α is the thermal diffusivity. 

 

Test Case for the Numerical Solution :- 
 
 
An Aluminium bar has an initial temperature of 600˚C and kept in an oven. To make it cool, it 

has taken from the oven and kept with it’s ends on two heat sources. The temperature of the left 

end heat source is 200˚C and right end heat source is 400˚C. Find the temperature distribution 

throughout the bar with an time interval of 0.2s. Take the following condition for computation, 
 
 

                                                      d= 0.5    →  Diffusion coefficient 

                                                       

                                                       α = 0.0029  m2/s 

 
The full MATLAB given below gives the solution for this problem :- 

 
 
%%%% Transient heat conduction through a bar using Explicit Scheme %%%%% 

clc 

clear all 
 
%%%%%%%%%%%%%%%%%%%%%%%%%% PRE-PROCESSOR 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 
 
d=0.5; % diffusion coefficient  

T=0.2;  % the time in the second 

L=1;   % the length of the bar 

delX=0.1; % the length of the grid in the spacial direction  

alpha=0.2; % the the thermal diffusivity 
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n = L/(delX)+1; % total number of grids in the spatial direction 

delT = d*(delX)^2/(alpha); % the time interval 

m = ceil(T/(delT)+1); % the number of grid points in the time direction 

t= zeros(m,n);        % the solution Temperature matrix 

X = zeros(1,n);        % the spacial grid matrix 

for i=2:n 

    X(1,i)= X(1,i-1)+ delX;  % entering the elements of the spacial grid matrix 

end 

%%%%%%%%%%%%%%%%%%%%%%%%% SOLVER 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 

for i= 1:m 

    t(i,1)=200;  % Specifying the left end boundary condition 

        t(i,n)=400; % Specifying the right end boundary condition 

  for k = 1:m-1 

     for j=2:n-1 

       t(1,j)= 600; % specifying the initial condition of the bar 

        t(k+1,j) = d*t(k,j-1)+(1-2*d)*t(k,j)+d*t(k,j+1); % Appltying the FTCS Scheme to solve the 

tempersture at all time iterval at all the nodal points 

     end 

   end 

end 
 
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

%%%%%%%%%%% 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

%%%%%%%%%%% 

%%%%%%%%%%%%%%%%%%%%%%%%%% POST PROCESSOR (RESULT PLOT) 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

%                         

for i= 1:m 

  

pause(3)    % Pause is used to display solution at all the time interval 

     

    plot(X,t(i,:),'-rp') % Command to plot space  verses temperature with time increement 

        title(' Temerature variation along the length of the rod after time T (0.2 seconds) ') 

xlabel('Length (m)') 

ylabel('Temperature (K)') 

grid on 

end 
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Result :- 
 
 
 

 
 

 

 

                                                                            **END** 
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EXPERIMENT NO-III 

NAME OF THE EXPERIMENT: Write a program to solve one dimensional transient heat 

conduction equation using explicit finite difference method. 

 

AIM: - Solution of one dimensional transient heat conduction through a bar using finite element 

method. 

 

The one dimensional transient heat conduction equation is given as, 

 

 

…………………………..(1) 

 

 

where α is the thermal diffusivity. 

  

Test Case for the Numerical Solution :- 

 
 
An Aluminium bar has an initial temperature of 600˚C and kept in an oven. To make it cool, it 

has taken from the oven and kept with it’s ends on two heat sources. The temperature of the left 

end heat source is 200˚C and right end heat source is 400˚C. Find the temperature distribution 

throughout the bar with an time interval of 0.01s. Take the following condition for computation, 
 
 

                                                     d= 0.5    →  Diffusion coeffient 

                                                       

                                                       α = 0.0029  
 
The full MATLAB given below gives the solution for this problem :- 

 
%%% 1D Heat conduction 

%%% Raushan Kumar 
%%%[1] Strang G. and Fix G. (2008): An analysis of the Finite Element Method,Second Edition, 
Wellesley-Cambridge Press, Wellesley USA 

 
%%%--- Problem ---%%% 
% Solving 1-D Heat diffusion in a unit rod 
%  
clear all 
clc 

 
%%%--- Mesh generation ---%%% 
h=0.2;                      % Distance between nodes [m] 
units=20;                   % Length of rod 
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p=[0:h:units]';             % Nr of nodes 
x = [0:h:units];            % Spatial discretisation 
nr_nodes = length(p);       % Nr of nodes 

 
  for i = 2:nr_nodes        % Creates the element matrix 
      e(i-1,:) = [i-1 i]; 
  end 
   
%%%--- Creating space ---%%% 
nr_elements =length(e);     % Nr of elements 

 
K=zeros(nr_nodes,nr_nodes); % Empty stiffness matrix 
M=zeros(nr_nodes,nr_nodes); % Empty mass matrix 
F=zeros(nr_nodes,1);        % Empty forcing vector 
Q=zeros(nr_nodes,1);        % Initial forcing vector,  

 
%%%--- Parameters ---%%% 
P=1;                       % Heat conductivity 
pc=1;                      % Heat capacity 
A=1;                       % Element cross section 

 
%%%--- Assembling matrices ---%%% 
for k = 1:nr_elements                        % Loop over all elements 
     
        nodes=e(k,:);                        % Identify nodes 
        h=p(k+1)-p(k);                       % Calculate distance between nodes 
         
        Ke = ((A*P)/h)*[1 -1;-1 1];          % Stiffness entry 
        Me = ((pc*A*h)/6)*[2 1;1 2];         % Mass entry        
        Fe = ((A*h)/6)*[2 1;1 2]*Q(nodes,1); % Forcing entry 
                             
        K(nodes,nodes)=K(nodes,nodes)+Ke;    % Position stiffness entry at identified nodes 
        M(nodes,nodes)=M(nodes,nodes)+Me;    % Position mass entry at identified nodes       
        F(nodes,1)=F(nodes,1)+Fe;            % Position forcing entry at identified nodes           
end 

 
 
%%%--- Initial conditions ---%%% 
Told=zeros(nr_nodes,1);     % Initial temperature, 0 everywhere 
F(1)=1;                     % With unit heat production at node one 

 
%%%--- Time parameters ---%%% 
dt = 0.01;                  % Size of time step 
t=1;                        % Time 

 
%%%--- Preparing matrices ---%%% 
% See [2] page 108 

 
A=((1/2)*K+(1/(dt))*M);      
B=(-(1/2)*K+M/(dt));         

 
C=(M+0.5*dt*K);              
D=(M-0.5*dt*K);              
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R=((1/3)*K+(1/(2*dt))*M);    
S=((-1/6)*K+(M/(2*dt)));     
  
R(nr_nodes,:)=0; 
R(:,nr_nodes)=0; 
R(nr_nodes,nr_nodes)=1; 

 
S(nr_nodes,:)=0; 
S(:,nr_nodes)=0; 
S(nr_nodes,nr_nodes)=1; 

 
Tnew = Told; 
Fold = F; 
Fnew = Fold; 

 
%%%--- Time stepping ---%%% 
for i = 1:t/dt 
     
    thermometer(i)=Tnew(1);                    % Vector to store temperature data at node 1 

 
  %  Tnew = C\(D*Told+dt*F) ;                  % Crank Nicolson 
   Tnew=R\((S*Told+((1/6)*(Fold+2*Fnew))));    % Galerking 
  
   Told=Tnew; 

 
end 

 
 
%%%--- Analytical solution ---%%% 
tt=[0:dt:t-dt];         % Time discretisation 
         
for nt = 1:length(tt)   % Loop over time 
  
% Analytical solution 
Tana = 2*(tt(nt)/pi)^(1/2)*((exp((-x.^2./(4*tt(nt))))-0.5.*x.*(sqrt(pi/tt(nt)).*erfc((x./(2*sqrt(tt(nt)))))))); 

 
thermometerTana(nt)=Tana(1);    % Store temperature at node 1 
end 

 
  figure(1) % [2] page 109 
  plot(x,Tnew,'ro',x,Tana,'b') 
  title('Temperature distribution in rod') 
  xlabel('Length') 
  ylabel('Temperature [C]') 
  legend(['Galerkin dt=',num2str(dt)],'Exact') 
  axis([0 2 0 1.4]) 
%      
  figure(2) % [2] page 110 
  plot(tt,thermometerTana,tt,thermometer,'r') 
  title('Temperature at point x=0 (Heating Curve)') 
  xlabel('Time [s]') 
  ylabel('Temperature [C]') 
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  legend('Exact',['Galerkin dt=', num2str(dt)]) 
%      
     
%  Tnew1=Tnew; 
%  Tana1=Tana; 

 
%   Tnew05=Tnew; 
%   Tana05=Tana; 
% %      
%   Tnew01=Tnew; 
%   Tana01=Tana; 
%    
%    
%   figure(1) 
%   plot(x,Tnew,'ro',x,Tana,'b',x,Tnew1,'ro',x,Tana1,'b',x,Tnew05,'ro',x,Tana05,'b') 
%   title('Temperature distribution in rod') 
%   xlabel('Length') 
%   ylabel('Temperature [C]') 
%   legend('Galerkin dt=0.01','Exact') 
%   axis([0 2 0 1.4]) 

RESULT:- 

  
 

**END** 
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EXPERIMENT NO-IV 

NAME OF THE EXPERIMENT: Write a program to solve one dimensional transient heat 

conduction equation using implicit finite difference method. 

 
AIM:- solution of one dimensional transient heat conduction  through a bar using finite 

difference implicit method. 

 
 
The one dimensional transient heat conduction equation is given as, 
 

 

 

 ……………………….(1) 

 

where α is the thermal diffusivity. 

  

Test Case for the Numerical Solution :- 

 
 
An Aluminium bar has an initial temperature of 600˚C and kept in an oven. To make it cool, it 

has taken from the oven and kept with it’s ends on two heat sources. The temperature of the left 

end heat source is 200˚C and right end heat source is 400˚C. Find the temperature distribution 

throughout the bar after an time inte
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**END** 
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EXPERIMENT NO-IX 

NAME OF THE EXPERIMENT: CFD analysis of flow through a diverging section using 

CFD software. 

 

Aim: To simulate flow through diverging channel. 

Problem Description: consider water is flowing through a symmetrical diverging section having 

inlet area 314.15926 mm , outlet area 706.858347 mm , length of channel is 50 mm and inlet 

velocity 5m/s and pressure 3 X 105 gauge discharging into the atmospheric condition. Assuming 

steady state condition & calculate the velocity variation inside the function numerically using 

software package Ansys CFX. The other conditions are given below: 

                       Atmosphere pressure =101.525 Pa 

Water density =1000 kg/m3 

Atmospheric temp = 288.16K 

Governing equation required: 

 To solve this problem the following equation required: Continuity equation 

Steps involved in fluid flow (CFX): 

1. Creation of geometry: 

a)  fluid flow (CFX) → Design model 

b) Geometry → modeling → x-y plane → sketching →draw→polyline →draw diverging 

chaneel → specify dimensions. 

c) specify the correct dimension and completer 2D-geometry. 

d) Go to revolve → select geometry → select axis → generate. 

e) 3-D geometry completed. 

f) Create a folder with your name→save the file in the new folder in your named 

folder→named it as exp name. 

g) print review and save the picture in the project folder. 
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2. Creation of mesh: 

Fluid flow (CFX) → meshing  

Mesh → Detail of mesh → Sizing→ Use advance size function → select off → create 

mesh→ now the software will create mesh→Sizing →use advanced size function→one 

proximity and curvature→ Update mesh 

Go to print preview and save the mesh geometry. 
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3. Creation of setup: 

Fluid flow (CFX) → CFX –Pre. 

Zoom your Geometry 

Default domain → (right click) rename →pipe 

left click on pipe → fluid model →material library → under material choose water→Ok 

Select pipe→(right click) Insert →Insert boundary → named it as Inlet →boundary 

inlet→ (Basic setting) location → Choose appropriate inlet boundary in your geometry→ 

boundary detail →normal speed → specify normal speed (as per given in the problem) 

→Ok 

Select pipe→(right click) Insert →Insert boundary → named it as outlet →boundary 

outlet→ (Basic setting) location → Choose appropriate inlet boundary in your geometry→ 

boundary detail →relative pressure→ specify relative pressure (as per given in the 

problem it is zero) →Ok 

Select pipe→pipe default→named it as pipe wall (right click and rename) →(left click) 

boundary  pipe wall→basic setting →specify wall location→boundary detail→specify no 

slip boundary condition (applicable for viscous flow )→Ok 

Save the file in the same folder. 

Save the picture in the same folder. 
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Solution:- 

Fluid flow (CFX) → CFX- solver manager. 

Define run →run difinition → Using double precession run the simulation →Start run. 

Check the workspace if solution diverged then go for result & if not move to back & 

look your grid → if required changed it →repeat the above steps from meshing onwards. 

5. Result:- 

Fluid flow (CFX) → cfd-post. 

Select the contour and analyze the result for full domains. 

Outline →pipe→tick mark on inlet, outlet and pipe wall →user location and plots→wire 

frame→ default legend view→ click contour →details of contour 1→ domains → 

pipe→location inlet →variables →pressure, velocity →apply → change other locations → 

see the flow variable variations →analyze your result. 

Save file in the folder. 

Save the picture in the same folder. 

Take print of report views. 

Discuss your result. 

 

 

 

**END** 
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EXPERIMENT NO-X 

NAME OF THE EXPERIMENT: Analysis of flow through converging section using CFD 

software. 

 

Aim: To simulate flow through Converging channel. 

Problem Description: consider water is flowing through a symmetrical diverging section having 

inlet area 706.858347 mm2, outlet area 314.15926 mm2, length of channel is 50 mm and inlet 

velocity 5m/s and pressure 3 X 105 gauge discharging into the atmospheric condition. Assuming 

steady state condition & calculate the velocity variation inside the function numerically using 

software package Ansys CFX. The other conditions are given below: 

                       Atmosphere pressure =101.525 Pa 

Water density =1000 kg/m3 

Atmospheric temp = 288.16K 

Governing equation required: 

 To solve this problem the following equation required : Continuity equation 

Steps involved in fluid flow(CFX): 

1.Creation of geometry: 

a)  fluid flow (CFX) → Design model 

b) Geometry → modeling → x-y plane → sketching →draw →polyline→ draw converging 

geometry→specify correct dimensions. 

c) specify the correct dimension and completer 2D-geometry. 

d) Go to revolve → select geometry → select axis → generate. 

e) 3-D geometry completed. 

f) Create a folder with your name→save the file in the new folder in your named 

folder→named it as exp name. 

g) print review and save the picture in the project folder. 
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2. Creation of mesh: 

Fluid flow (CFX) → meshing  

Mesh → Detail of mesh → Sizing→ Use advance size function → select off → create 

mesh→ now the software will create mesh→Sizing →use advanced size function→one 

proximity and curvature→ Update mesh 

Go to print preview and save the mesh geometry. 

3.creation of setup: 

Fluid flow (CFX) → CFX –Pre. 

Zoom your Geometry 

Default domain → (right click) rename →pipe 

left click on pipe → fluid model →material library → under material choose water→Ok 

Select pipe→(right click) Insert →Insert boundary → named it as Inlet →boundary 

inlet→        (Basic setting) location → Choose appropriate inlet boundary in your 

geometry→ boundary detail →normal speed → specify normal speed (as per given in the 

problem) →Ok 

Select pipe→(right click) Insert →Insert boundary → named it as outlet →boundary 

outlet→ (Basic setting) location → Choose appropriate inlet boundary in your geometry→ 

boundary detail →relative pressure→ specify relative pressure (as per given in the 

problem it is zero) →Ok 

Save the file in the same folder. 

Save the picture in the same folder. 

4. Solution:-  

       a)   Fluid flow (CFX) → CFX- solver manager. 

      b)    Define run →run difinition → Using double precession run the simulation →Start run. 

Check the workspace if solution diverged then go for result & if not move to back & look 

your grid → if required changed it →repeat the above steps from meshing onwards. 
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5. Result 

      a)   Fluid flow (CFX) → cfd-post. 

     b)    Select the contour and analyze the result for full domains. 

     c)   Outline →pipe→tick mark on inlet, outlet and pipe wall →user location and plots→wire     

frame→ default legend view→ click contour →details of contour 1→ domains → pipe→location 

inlet →variables →pressure, velocity →apply → change other locations → see the flow variable 

variations →analyze your result. 

    d)   Save file in the folder. 

    e)    Save the picture in the same folder. 

    f)    Take print of report views. 

    g)    Discuss your result. 

 

 

**END** 
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EXPERIMENT NO-XI 

NAME OF THE EXPERIMENT: Analysis of convection heat transfer of a bar in air using 

CFD software. 

 

Aim:-  Compute the transient temperature distribution throughout the bar. 

 

Problem Statement:- 
 
A cylindrical steel bar having an initial temeperature of -50˚C, surrounded by atmospheric air at 

20˚C. Find the time required to attain the temperature of the bar equal to the surrounding 
temperature, due to natural convection. 
 

Govering Equation:-  

 
1. Energy Equation (Heat convection equation) 
 
Solution Using ANSYS WORKBENCH  Transient Thermal Analysis System 

 
1. First put the appropriate engineering data for the prolem statement 

 

Go to the workbench →Analysis System → Transient Thermal → Engineering data → (Click over 

engineering data) → Engineering data source →select structural steel → check the property of 

structural steel → close it and return to the project schematic →start with geometry. 
 
 
2. Geometry:- 

     

Design Modular →choose Xyplane→view→sketching→Draw→circle→specify it’s 

dimension(1m)→ extrude →geomerty →apply FD1, depth(>0)→ 5 m→ 
Generate → save the file in the folder → save the picture in the folder 
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3. Model 

 

mesh→ update → transient thermal→ insert →connection →geomerty →seect geometry all 

face→apply → geometry→    apply→ details of connection→definition →film coefficient →left 

click→import temperature dependent→ sta gnent air (simplified case)→ ok→ change film 

coefficient →10W/m²k (step applied)→ ambient temp→ 295.15K →outline →initial tamp→ initial 

temp value -50°C →analysis setting→ step controls→ number of steps→ 30 →solution (A6)→ 

insert →thermal →temperature →select hole volume of the bar →geomerty →apply→ 

solution(A6)→ temperature→ after solver finishes it’s run temperature plot you will get. →save 

the   

picture and file →generate report  

 
 
 
 
4. Result :- 

Analyse your result. 
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                                                                                  **END** 
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EXPERIMENT NO-XII 

NAME OF THE EXPERIMENT: Determine the flow properties after mixing of two fluids in a 

duct using CFD Software.  

AIM:-  comparison of cfd simulation of hot and cold fluid mixing in t-pipe by placing nozzle at 

different places. 

 
 
As the hot water and cold water enters at different velocities of mixed flow will be increased as 

pressure decreases. Pressure for mixed flow at the outlet will be reduced because of the cross 

section variation at the joining point of hot and cold water and also high velocities will cause 

more pressure drop. Turbulence is created at the inter section point of the T-pipe because the 

cross section at that point has changed suddenly and also the velocity at that point has increased 

suddenly due to the mixing of hot and cold water at that point. 
 
 
 
Test Case for the Numerical Solution :- 

 
The geometry was done in the GAMBIT with measurements; pipe diameter is 50mm, radius of 

the pipe 25mm and length of the pipe 500mm. Defining required boundaries like inlet, outlet and 

wall of the geometry and mesh under tetrahedron.  

 

Defining the boundary conditions for the water. The velocity at inlet of the cold fluid is 4m/sec 

and at outlet is 2m/sec and the gravitational acceleration of 9.81 m/s2 in downward flow 

direction was used. 
 
Governing Equation Required:- 

 

Continuity Equations 

Momentum Equations 

Bernoullis Equations 
 
Solution Strategy:- 
 
The simulation is done in the FLUENT based upon the governing equations.  

 

The steps followed in the fluent are define Model, define Material, define cell zone, boundary 

condition, solve, iterate, and analyze results. 

 

 
The model and result are shown in figure:- 



41 
 

 
 
The following figures shows that velocity, turbulence and temperature plot during mixing. 
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 **THE END** 
 
 
 
 


